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MODIFYING MICROSOFT FLIGHT
SIMULATOR 2002: PROFESSIONAL EDITION

By Craig Wessel

Have you ever had the urge to build your own aircraft and fly it in
Microsoft Flight Simulator 2002: Professional Edition? Have you always
wanted to create scenery of your home town and fly over it in the
simulation? If you’re an experienced FS2002 pilot, or if you enjoy creating
modifications of your own, Flight Simulator 2002 Pro ships with some
tools that can be used to edit existing aircraft, create aircraft, and modify or
create scenery. This is good news for the FS2002 community, as it ensures
a long life for the product long after you’ve flown everything that comes
with the simulation.

However, the bad news is that there is no single tool you can use to
do all these things— some of them are on the FS2002 Pro CD, but some of
them have to be installed manually, as well as configured to work with the
program. You’ll also need some external tools.

What I’ve done here is compile the basic procedures you need to
follow in order to get your own aircraft into the air, edit an existing aircraft,
or work with scenery. What | have not done is give you every detail of
every step along the way. The tools we’ll be discussing have tutorials that
cover the nuts-and-bolts of what we’re doing—you don’t need me to re-
hash that material. What I’m focused on here is getting what you’ve created
to work in the simulation. We’ll discuss:

» Editing existing aircraft
» Creating and importing aircraft

» Editing textures and scenery
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Getting Started

You’ll need to use at least one, and sometimes more than one,
external program to do any editing and creating. The tools you’ll need are:

» gmax (it’s on the FS2002 CD, but not fully installed)

» Aircraft editor (already installed in your FS2002 Pro program
group)

* Image Tool (already in your FS2002 gmax directory)

» Bitmap editor (Paint Shop Pro, Photoshop, or another graphics
editor. You can use Paint, but it won’t do layers, making your
task very difficult.)

First, we need to get things installed so they will work properly.

Installing and Setting Up Your Tools

I’m assuming that you’ve already installed Flight Simulator 2002. If not, do
so now. Once installed, you’ll find the tools we need in the sub directories
of the installation directory (C:/Program File/Microsoft Games/FS2002 by
default).

gmax

gmax, published by Discreet, is the little brother of one of the most
powerful 3D editors around, 3D Studio Max. It can be used to create
models for many games, animate models, apply textures, assign behavior to
models, and create architecture (game maps or objects). In short, just about
everything you’d want to do can be done. But we’re only concerned with
using gmax for aircraft-related editing.

gmax includes a very detailed tutorial on creating an aircraft model.
Once you have created the model, you can then import it into FS2002.
We’ll go into more detail on how this is done later. For now, let’s get gmax
set up to work properly.

For our purposes here, an aircraft model is the structure of
the aircraft itself. Think of it as the exterior of the aircraft,
and that will be close enough for now.
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Setting up gmax

gmax can be found in the gmax sub-directory of the main FS2002 directory
(C:/program files/microsoft games/Fs2002/gmax by default). Using
Windows’ File Manager, open this directory to start setting up gmax, then
follow these steps:

1. Click on gmax setup.exe to run set up.
2. Select an installation directory (we use C:/gmax).

Be sure to install the Flash 5 controller when asked—gmax
won't work without it!

3. Now, go to the directory you installed gmax from (not to) and
open the FLIGHTSIM folder (C:/program files/microsoft
games/Fs2002/gmax/Flightsim)

4. Copy the contents of both the “Gamepacks” and “plugins”
directories into the same directories in your new gmax
installation directory (C:/gmax/gamepacks and C:/gmax/plugins).

5. Now, navigate back to the directory from which you installed
gmax (C:/program files/microsoft games/Fs2002/gmax) and go
into the “Help Install” directory. Click on “gmax_help.exe” and
place the contents in your new gmax help directory
(C:/gmax/help). Do the same with the “gmax_tutorials.exe” file,
but place it in a tutorials directory (C:/gmax/tutorials). The
current tutorials directory in your new gmax folder is empty.

6. Once you have the FS2002 gamepack and plugins placed in your
new gmax directory’s “Gamepacks” and “plugins” sub-
directories, and the help and tutorial files in place, you're ready
to use gmax with FS2002..

The Aircraft Editor

Now that we’ve got gmax squared away, let’s make sure that the Aircraft
Editor is correctly installed. The Aircraft Editor is what we will use to edit
the actual panel design, sounds, textures, and flight dynamics of our
aircraft. Every detail about the various aircraft that came with FS2002 can
be found using the Aircraft Editor.

Flight Dynamics refer to the way the aircraft will behave in
the air. Using the Aircraft Editor, you can change all
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aspects of an aircraft’'s behavior—but not always with good
results!

This program is better integrated with FS2002 than gmax. In fact, it
should already appear in your Windows Task Bar Start menu. Open the
Start menu and find “Programs ->Microsoft Games ->FlightSimulator
2002”. The Aircraft Editor should be the first program inside this menu.

If it isn’t, you can install it from the CD at any time. Simply insert
Disc 1, and when prompted, agree to install the Aircraft Editor. That’s it—
you’re ready to go.

Image Tool

This program also already exists in your FS2002 directory. Look under
FS2002/gmax/Flightsim/gamepacks/Flightsim. You’ll use this program
when we begin working with textures.

Bitmap Editor

The last we’ll talk about is a bitmap, or graphics, editor. There is no one
tool that’s best for this—it’s really a matter of personal preference, and how
much work you plan to do in creating your own graphics (scenery, textures,
and other items).

An editor like Corel Draw (www.corel.com) or Adobe Photoshop
(www.adobe.com/products/photoshop/main.html) will work, as will Paint
Shop Pro (www.jascsoftware.com/products/psp/). The important thing is to
choose a graphics editor that you are comfortable with, and allows working
with layers.

Any of the programs mentioned above will be able to export various
file formats with ease. Add some basic artistic ability, and you’ll be able to
create your own textures and other artwork at will. We won’t be talking
about graphic editing much (see the Resources section for links to some
good tutorials and the like), but a bitmap editor is a must-have tool if you
want to do this kind of work.

Now that we’ve got the tools we need, we can begin talking about
the fun stuff. We’re going to start with editing existing aircraft, and then
we’ll move on to creating our own aircraft, textures, and scenery.
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Editing Existing Aircraft

The Aircraft Editor is the tool you will use to edit existing aircraft, the
aircraft that came with FS2002 Pro. If you include the different paint styles,
there are 46 aircraft that shipped with the simulation. Since you are reading
this, | assume you’re ready to tweak some things and see what you can
come up with.

Aircraft Editor Overview

Let’s take a quick look at the Aircraft Editor itself before we begin editing
anything. From the Start menu, open the Microsoft Games->FS 2002 menu
and select Aircraft Editor.

When the editor is open, you’ll see a split display. The left pane of
the display shows the directories and elements that you can manipulate—it
works like Windows File Manger—and the right pane shows the detail. The
best way to learn the Aircraft Editor is to use it, so let’s take a look at an
aircraft and get familiar with how to get around.

From the text menu at the top of the Aircraft Editor, click on File
and then select Open.... You should see a pop-up box entitled “Open
Aircraft for Editing” that contains all the aircraft currently in your FS2002
directory.

If you don’t see any aircratft listed, make sure that the
Aircraft Directory is set properly. It should be set to the
main FS2002 directory on your hard drive.

Select the first aircraft, “Boeing 737-400” and click OK. Now, you
should see your Boeing 737 listed in the left panel of the Aircraft Editor.
Click on the “+” next to it to access all of the aircraft’s detail.

Let’s take a look at each editable element:

Panel

This is where FS2002 looks for the graphic to display on the instrument
panel. If you click on “Panel” in the left panel of the editor, you’ll see
several different views of a Boeing 737’s instrument panel.
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Sound

All sounds associated with the aircraft are found here. If you click on
“Sound”, the list of available sounds for the aircraft will appear in the right
panel of the editor. Double-click on a sound in the right panel to hear it.

Texture
Textures are the bitmap images, or graphic files, that FS2002 needs to use
when displaying the aircraft in the simulator.

Flight Dynamics

This is the meat of the editor. When you click on “Flight Dynamics” in the
left panel of the editor, you’ll see several tabs in the right panel of the
editor: Configuration, Controls, Flaps, Weight and Balance, Jet Engine,
Fuel, Gear, and Tuning.

When you open an aircraft that comes with FS2002 in the
Aircraft Editor, it is in “Read-only” mode. You cannot edit it,
and in fact the General Information and Flight Dynamics
detail are grayed out. This keeps someone from
accidentally ruining a perfectly good aircraft by changing
settings that should be left alone!

Editing an Existing Aircraft

The first thing you need to do in order to edit one of the aircraft that
shipped with the simulationis to make a copy of it. As mentioned above,
you cannot change settings for an existing aircraft—they will all open in
“Read-only” mode in your editor.

To create a copy of our 737 so you can edit it, highlight the aircraft
in the editor, then select File > Save Copy As from the editor’s text menu.
A dialog box will appear, and you can type in a name for your new aircraft,
or accept the one the editor suggests.

Once you’ve completed this step, you’ll see the new aircraft appear
in the left panel of the Aircraft Editor. You’ll notice that the General
Information and Flight Dynamics are no longer grayed out; you can now
freely edit this aircraft without damaging the original.
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Changing General and ATC Information

When you highlight your new aircraft in the left panel of the Aircraft
Editor, the right panel contains some general information about the aircraft.
You’ll see two sections, Aircraft Info and ATC (Air Traffic Control)
Information. You can change the Aircraft Info if you like; it’s only general
information about the aircraft. The ATC information is important, since this
Is the data that the in-flight Air Traffic Control will use to identify you—in
general, you can leave this alone.

The Description field is a good place to jot notes to yourself about
what you’ve done (or plan to do) that differs from the original. Aside from
that, you can rename the aircraft from this screen, and choose different
ATC information if you choose. ATC information is how the control tower
will refer to you.

You can edit the drop-down lists in the ATC section, adding
your own information, but if you choose an airline,
manufacturer, or aircraft type that isn’t included in FS2002,
ATC will not be able to use it to identify you.

Editing the Panel

It might appear to be a simple thing, but editing the panel graphics and
panel behavior of any aircraft can be quite complicated (particularly a 737
or other commercial aircraft). It’s one thing to export the panel graphics and
make slight cosmetic changes, and quite another to alter the panel layout
and have it function properly in FS2002.

Take a look at the panel of your aircraft by clicking on Panel in the
left pane of the editor, then selecting Main Panel. You’ll see the graphic
appear in the upper right panel, but there’s more than just graphics going on
here. Click on different areas of the panel display, and you’ll see a blue
outline around them. You’ll also notice that there are individual dials and
gauges in the lower-right panel display. Click on them, and you’ll see that
they have names, such as “spitfire_mki!Vertical_Speed”. As you click
around the upper-right display, you’ll also see that there are a set of
numbers displayed at the bottom of the editor screen that change depending
on where you click.:
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Left=

Top=

W dt h=

Hei ght =
So what do we have here? The visual portion of the instrument panel is
only part of what’s embedded in each aircraft’s panel.

Making Cosmetic Changes

It’s a given that the entire instrument panel (and all sub-panels) must fit
within the aircraft you’ve chosen to edit. It’s a fairly simple thing to export
the graphics shell—the gray border around all the dials and gauges—for the
Main Panel and change them cosmetically. Go into your aircraft’s directory
from Window’s File Manager—make sure you choose your aircraft, and
not the original you copied!

é Always back up any files you plan to edit. Copy them into
another directory BEFORE you make any changes to
them.

Open the Panel directory, and you’ll see several bitmap files (those
with a “.bmp” extension). Open these in a graphics editor and you can
easily make cosmetic changes—make the background orange or put a
corporate logo on the panel. Be sure that you don’t change the image size
or resolution because this would alter the way it looks in FS2002. Save the
altered files back to your aircraft’s Panel directory with the same names
they had, and they will work just fine.

Making Other Changes

If painting the panel orange isn’t what you’re after, then you’re probably
interested in re-arranging it, or editing the graphics of the actual dials and
gauges.

You can drag and drop different dials and gauges into the current
panel. In the upper-right panel of the editor, click on the object you want to
delete from the panel. Once it’s highlighted in blue, hit your Delete key and
it will disappear. Now drag a gauge or dial from the bottom-right panel of
the editor, and drop it in the black space where the old one was. If you need
to resize it, click on it again and drag the sides or corners until it fits.

é Do not attempt to re-arrange an aircraft’s panel or
instrumentation unless you are fairly capable at both
graphics manipulation and overall editing.
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To get a look at what’s behind your aircraft’s panel, enter your aircraft’s
directory from Windows Explorer, and open the “panel” folder. Inside,
you’ll find a file named, “panel . cf g.” Back up this file before you
continue—make a copy and name it, “panel . ol d” or something else
recognizable.

Note that your aircraft’s panel . cf g file is copyrighted by
Microsoft Corporation. What this means is, if you edit it and
then sell it to someone else, you could get sued. So, just
remember, kids, this is all for fun and your own personal
enjoyment.

Understanding how this file works is the key to truly editing your
instrument panel. In general, this file tells FS2002 which gauge functions
belong where, and how they appear in the panel. The easiest way to
understand this is to take a look at one of the gauges in the panel . cf g file.

Within the panel . cf g file, there are several sub-sections, each
corresponding to a Window title. Window titles are the sub-panels that
appear in the Aircraft Editor under the Panel section:

[ Wndow Titles]

wi ndow00=Mai n Panel

wi ndow01=Radi o St ack

wi ndow02=GPS

wi ndow03=Throttl e Quadrant

w ndow04=0Over head Panel
wi ndow05=Conpass

Let’s look at the first sub-section for Window00, the Main Panel:

[ W ndow00]
file=Main_640. bnp

file 1024=Mai n_1024. bnp
si ze_mMm=640

posi tion=7

vi si bl e=1

i dent =MAI N_PANEL

gauge00=737- 400! Ai rspeed, 0, 64
gauge01=737- 400! Fl aps, 586, 64

The first area of this sub-section tells FS2002 which .bmp file to display as
the main panel shell. If you look in the Panel directory under your new
aircraft, you’ll find the files mai n_640. brp and mai n_1024. bnp. It also gives
the size and position of the file, and it tells FS2002 how to display the
Main Panel shell in the simulator.

The next section details each of the gauges that appear in the Main
Panel shell, as well as their position. Take a look at this line:
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gauge00=737- 400! Ai rspeed, 0, 64

This tells FS2002 that the first gauge in the list, gauge00, is the 737-
400’s Airspeed gauge, and that it is positioned at 0,64 (0 horizontally, 64
pixels vertically) in the Main Panel shell graphic. You’ve already seen the
graphics for the gauges, but how does FS2002 know how the Airspeed
gauge for a 737 acts?

There is a “Gauges” sub-directory in your main FS2002 directory.
Within this directory, you can see that for each aircraft type, there is a file
with a “.gau” extension. These files are the actual code that tells FS2002
how each gauge behaves in the simulation. It is this file that the panel . cf g
file is referencing to fill the Main Panel shell with the proper, working
gauges.

é Do not edit the .gau files in the Gauges sub-directory. If
you feel you must mess with them, back them up first!

You can change the gauge shown in any of the aircraft’s panels by simply
changing one of the lines in the panel . cf g file and placing its associated
gauge in the panel view. Bear in mind that unless the gauge is exactly the
same size as the one it’s replacing, you’ll have to resize it after dropping it
in so that it fits.

You can also find hundreds of other gauge configurations online.
Check the Resources section of this guide for more detail.

Working with Sounds

The sound section of the Aircraft Editor is fairly straightforward. Assuming
you’ve still got our 737-400 open in the editor, click on the Sound icon. A
list of all the sounds the aircraft uses will appear in the right pane of the
editor.

You can double-click on any sound to play the associated .wav file.
You shouldn’t have a need to, but you can replace any of these files with
another one by right-clicking on a sound, and choosing, “Change sound.”
As always, be sure to back up the old sound file so you can restore it if
there’s a problem. (Backing up isn’t entirely necessary as you’re just
changing the association rather than deleting files—but you know how it is.
Once you don’t back something up, you’ll wish you had!)

If we take a look at the sound. cf g file that exists in our aircraft’s
Sound directory, you’ll notice something interesting. To keep the size of
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the .wav files used to create sound in the simulation smaller, the files are
linked together. For instance, under the heading [ STARTERA] , we have:

[ STARTERA]

fil ename=banlstrt

Vi ewpoi nt =1

link=starterA. 1

[ STARTERA. 1]

fil enane=xbanlstrt

Vi ewpoi nt =2
Note that the sound played when sTARTERA is called (banlstrt) has a link
value that points to the next section, STARTERA. 1. This allows FS2002 to use
sounds without having them become too large, or taking too long to load.
That’s useful to keep in mind when using your own sounds—Iink them for

better results, rather than creating one huge sound file.

Working with Textures

Textures are used for things such as decals, and other surfaces in FS2002.
You can right-click on any texture, and select Edit to work on it in your
system’s graphics editor. However, avoid editing in this way. We’ll cover a
better way in more detail later. For now, just don’t resize it or change its
resolution..

The Flight Dynamics Editor

The most important, and therefore the most complex part of the Aircraft
Editor, is the Flight Dynamics Editor. With your copy of the 737-400
aircraft open, select Flight Dynamics from the editor’s left pane. Since this
is a copy, and not the original, all the Flight Dynamics info can be edited.

& Be very careful when editing flight dynamics and keep
notes of the changes you make. A good rule of thumb is,
unless you know something should be changed, and what
the change will do, leave it alone.

We’re not going to cover every setting here as you will find basic
descriptions of each tab and their settings in the FSHELP file that can be
accessed from the Aircraft Editor’s text menu.

The tabs available across the top of the editor will vary depending on
the type of aircraft. As a general rule, all aircraft will have the following
tabs:
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» Configuration: This tab defines the geometry of the aircraft, so
it has settings that deal with aerodynamics.

» Controls: This tab defines the controls (elevator, aileron, rudder,
and spoiler) of the aircraft.

* Flaps: As you would expect, this is where you define the number
and types of flaps on the aircraft.

* Weight and Balance: This tab defines the weight of the aircraft
for various load outs.

* Fuel: This tab defines the number, position, and capacity of the
aircraft’s fuel tanks.

» Gear: This tab defines the gear and scrape point types of the
aircraft.

* Tuning: Leave this tab alone unless you know what you are
doing. It allows you to fine tune various settings.

There are other tabs that are specific to engine type (Jet, Piston, Turbo
Prop), and propellers. They will not appear unless you change the aircraft

type.

Creating and Importing Aircraft

We’ve gone over the Aircraft Editor in some detail, which will give you a
good foundation to use for this section.

gmax provides an excellent tutorial for creating new aircraft models
that will get you moving in the right direction, so we won’t cover that here.
We will touch on the process, but what we will focus on here is getting
those models to work with FS2002.

It’s worth pointing out that you should make sure that the aircraft
type you plan to create is already supported by FS2002, or that you can find
the data you’ll need to flesh out the Flight Dynamics of the aircraft. If you
wanted to, you could build a model that’s a boring cube, import it into
FS2002, and give it whatever flight characteristics you wanted. But then,
where’s the fun in that?

Unless you can accurately fill in the flight dynamics of an
imported aircraft model, it won'’t fly anything like its real-

Copyright © 2002 SYBEX Inc., 1151 Marina Village Parkway, Alameda, CA 94501. World rights reserved.



world counterpart. This is why it's best to stick to aircraft for
which you already have the necessary data.

Using gmax to Create an Aircraft Model

Without rehashing material that’s already discussed in the gmax aircraft
model tutorial, this section will go over the basic creation process so that
you can see what is involved.

1. Find or create a picture of the aircraft you want to model. The
picture needs to be in .jpg format to work with gmax. For best
results, find same-scale pictures that show top, side, and front
views. A picture created from scratchwill work, too, but it’s
much easier to use a picture as a guide than to try to “freehand”
one in gmax. An Internet search for “aircraft diagrams” or
“aircraft schematics” should produce what you need.

2. Convert the picture’s scale to real-world measurements. It
won’t do you any good to create a model if it’s not to scale. gmax
contains the tools to set the aircraft up so it’s to scale. More
importantly, it helps you set up the different views of the aircraft
so they are all in sync

3. Use the picture as the basis of your model. Models are created
from solid polygons that you move and stretch. Add and stretch
them in gmax to fit the contours of your picture, then delete the
picture.

4. Fine-tune the model. Make sure the model is as accurate as you
need it to be.

5. Animate the model. If your model has elements that need to be
animated (propellers, turbines, etc.), you can animate them in
gmax.

6. Texture your model. Create and apply graphics to your model.

7. Export your model in .mdl format. Use gmax to export the
model in .mdl format, and place it in the FS2002 aircraft
directory under a name of your choosing.

Now you have a model that can be imported into FS2002. Unfortunately,
you’re only halfway home. You now need to create the detail that FS2002
needs to make your creation fly.
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If the “Export” option is not available in gmax, copy all the
folders from the FS2002 gmax directory (where you
installed gmax from) into the root gmax directory (where
you installed gmax to) on your hard drive.

Importing an Aircraft Model into FS2002

In order to accurately import your creation into FS2002, you need data, and
lots of it. You can guess at it, but the more accurately you can input data
into the FS2002 Aircraft Editor, the more realistically your aircraft will
perform. Hopefully, since you’ve seen the data the Aircraft Editor requires,
you did some homework before you built your model to be sure that you
could get your hands on accurate data.

You are much better off if your creation conforms closely to one of
the aircraft already in FS2002. If you’ve just created a single engine plane
that resembles a similar Cessna, then you can use that aircraft’s data to
flesh it out, and then adjust it as you go. Performing a simple Internet
search for “aircraft schematics” or “aircraft specifications” should get you
the detail you need.

Components of Imported Aircraft

Take a look in your FS2002 “Aircraft” directory. You’ll see that each
aircraft in the simulator has its own folder. Within this folder, you’ll find
directories for model, panel, sound, and texture (sometimes more than one
of these). For your new model, you’ll need to provide the files to fill these
in, but you can do most of that work from inside the Aircraft Editor,

Inside the model directory, there are two files—an .mdl file (the
actual model for the aircraft) and a file named model.cfg. If you’re created
your model in gmax and exported it, you should have the .mdl file you
need. The model.cfg file is mostly empty, and likely only contains a line
like this:

[ model s]

nor mal =ai r cr af t name
You don’t need to do anything with this information just yet; we’ll come
back here once we get things rolling.
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Importing the Model
There are templates in FS2002 that you can use as the basis of any

imported aircraft. To begin importing your creation, let’s start by looking at
these.

Choose an Aircraft Template

From the Aircraft Editor, select File>New. A pop-up window will
appear with a list of the available templates. Choose the one that most
closely resembles your aircraft, click “OK”, and name it whatever you
want. Take note of the directory where the “For Your Information...”
dialog tells you it is placing your new aircraft.

Selecting a template that is similar to your model is
important; it will save you time and headaches later!

Panel and Sound Files

You may receive some error messages as the editor sets up your new
aircraft. One of these may refer to missing Panel components, and another
may refer to Sound files that you’ll be unable to edit directly. If you’ve
created your own panel and sound graphics, all you need to do is place
them where they belong (in the panel and sound folders of your aircraft’s
directory) using Window’s File Manager. If you plan on using the ones
from the template, you’ll have to copy them into your aircraft’s directories
before you can use them.

To do this, go to your aircraft’s directory under FS2002/aircraft.
Don’t remember your aircraft’s directory name? No problem—it’s usually
in a folder in your FS2002/aircraft directory with the same name as the
template you created it from.

Inside this directory, you’ll see an aircraft.cfg file. Open it up and
you’ll see two lines like this:

Panel _alias=aircrafttenpl at enane
Sound_al i as=ai rcrafttenpl at enane

Where “ai rcraftt enpl at enane” is the name of the aircraft the template is
based on. To make the panel and sounds editable in the Aircraft Editor,
simply find the directory for the aircraft the template is based on, then copy
the contents of the source aircraft’s panel and sound directories into your
aircraft’s corresponding directories. Re-open your aircraft in the editor and
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you should no longer get the error messages, and you’ll now be able to
edit/manipulate the panel and sounds.

Fill out the General Information and Flight Dynamics

You’ve got a brand new aircraft here, so you must tell FS2002 what
it is, and what its specs are. We’ve already discussed filling in General
Information and Flight Dynamics. If you created an aircraft that is very
similar to your template, congratulations. If not, you’ll need to find as much
data as possible in order to fill in the Flight Dynamics.

One of the more difficult things to do is placing the engines in their
proper positions. If you look at the Engine tab of the Aircraft Editor, you’ll
see a Properties section, as well as an Engine Position section. You should
be able to find the Properties of your engines in an online search, but the
positioning is something you’ll have to experiment with. If you don’t place
them properly, your aircraft’s performance will likely suffer. Use the
defaults for now, and you can tweak them once you’ve flight tested your
model.

& Remember, don’t change Flight Dynamics settings if you're
unsure what they do, or if you don’t have the proper
information to do so. See the Aircraft Editor Help file for
more detail.

Flight Testing your Model

Once you’ve got everything where it needs to be, you’re ready to fire up
FS2002 and see how your model looks in the simulation.

Save your work, then select, “Fly this Plane!” from the File menu of
the Aircraft Editor. Once you’re in the simulation, you’ll be sitting in the
cockpit of your new plane, ready for take off.

Check the panel, and all exterior views to see if your creation looks
the way it should. If not, take notes of what needs to be changed. Once in
flight, make sure it performs as you expected. If you’ve created an aircraft
that you’re familiar with, and want it to be exactly as it is in real life, then
you’ll probably need to spend a lot of time tweaking everything. Unless it’s
an issue with your model, for which you’d need to go back to gmax, you
can make most changes in the Aircraft Editor.
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Textures and Scenery

Working with textures in FS2002 Pro can seem confusing at first.
However, there are some shortcuts to getting the job done. There are tools
you can use that were included on your FS2002 Pro CD, and you can also
get some help from gmax if necessary. There are so many good sources for
this information online, I’m just going to hit the highlights here. Check the
Resources section of this guide to find the best sites to get more detailed
information.

Working with Textures

In FS2002 Pro, textures affect the way your aircraft appears. If you want a
new paint job on your aircraft, or if you want to redesign the look of your
panel shell, then you’ll need to edit (or create) those textures.

You may have noticed that if you opened one the texture files for
any aircraft using an outside editor, they appeared fuzzy or blurred. Never
fear—Microsoft has included a utility that will help you work with textures.
But you’ll have to find it first.

The utility is called Image Tool, and it’s located in the following
directory assuming a default installation:

C:\Program File\Microsoft Games\FS2002\gmax\Flightsim\gamepacks\FlightSim.

Once you’ve found it, create a shortcut for it on your Windows
Desktop so you don’t have to hunt it down again. Check the Resources
section of this guide for some links to other optional tools that you can use.

Now, take a look at the texture directory of one of the aircraft that
came with FS2002 Pro. In this directory, you’ll find several files. In fact,
you might even see several texture folders listed as “texture, texture.1,
texture.2.” This is how FS2002 keeps track of different texture sets for the
same aircraft.

Inside each of these folders, you will see .omp fileswith L, T, and
possibly even _C in their names. What does this mean? _L is the texture set
for light effects on the textures (night); _T is the basic texture with
reflections, and _C is the crash damage display set. You can create texture
set for all these instances, or just use one. However, if you only create one
set, your aircraft won’t show up at night, and if you crash it, it will look
pristine, rather than damaged.
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Editing Existing Textures

Open one of the texture files with Image Tool and take a look. This jumble
of images is what is being used to texture, or paint, your aircraft.

It's important to keep the images within the texture file in
their same positions, as this is the file that's used to texture
your model. As you edit, take care not to overlap other
images within the file.

Editing an existing texture is fairly straightforward. It’s still a complex
process, but since the steps are the same for any image, once you learn it,
you’ll become more comfortable with it each time you try.

1. Format the image for editing. Open the texture you want to edit
(use one of the _T textures for now) in Image Tool. It will look
odd because Image Tool shows you how the texture will look at
various resolutions—don’t worry about this. Select
Image>Format to 24-BitSave the file in another directory with
the same name as the original (use a “new textures” folder to
hold images you edit). For best results, use the .tga format.

Note that the original image was in DXT3 format. This is
important, as this is the format the final, edited image must
be in for it to work in FS2002 Pro.

2. Open the new file in your graphics editor. We used Paint Shop
Pro to edit the file. Open the file, and you’ll be in business.

3. Use Layers. Every good graphics editor lets you work in layers.
Instead of editing the base image (the one you just opened), you
should always add layers. That way you can easily undo a layer,
instead of having to re-work the entire image.

4. Edit the image. Make the modifications you want to make to the
Image, remembering to create new layers for each major change
(text, shading, etc.).

5. Save the image. Be sure to save it in a format that supports layers,
such as Paint Shop Pro’s .psp format, or you’ll flatten the image
and lose all your layers. Now save it as a bitmap (.bmp), and
open it up in Image Tool.

6. Re-format the image for FS2002. Once you have the image open
in Image Tool, select Image, then Format to DXT3. Now, save
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the image to a texture directory within your aircraft’s main
directory (ie Texture, Texture.1, Texture.2).

7. Edit aircraft.cfg. In your edited aircraft’s directory, be sure that
you set it up so that the proper textures appear based upon your
airline selection. This is done by changing the line: texture=to
1, 2, or whatever matches your new texture’s directory. You can
also change the ui _vari at i on= line to match a new airline name
if you’ve given it one.

8. Repeat this process for each type of texture. If you want your
texture to appear properly in full light, darkness, and when you
crash the plane, go the extra mile and create all three types of
textures. Just be sure you place them in the proper directory—see
any existing aircraft’s texture directory to be sure you get it right.

8. Fly the aircraft and check out your handiwork!

That’s it. You’re basically set, although there are more details to each step
in the process Check the Resources section of this guide for more help.
The important thing to remember is to save your work in stages, so you can
easily undo something that turns out badly.

Creating New Textures

To create new textures, you need to be able to generate a texture file that
will wrap the model you’ve created properly. The best way to do this is to
create your textures within gmax and then export them with the .mdl file.

Just as we did when discussing model creation, I’m not going to go
into the specifics of doing this in gmaxbecause that program contains a help
file (select Help from the main menu) that outlines the process in great
detail. What I will do here is give you the general procedure.

1. Open the gmax material editor. This is where all the work on
materials (as gmax calls textures) is done. Click “New” and name
your new material.

2. Enter settings for the material components. gmax will walk
you through the settings you need to use to make your material
look right on the model (diffuse color, shininess, opacity, lights
and shading, and more).

3. Assign texture maps to the material. Texture maps give your
material a level of complexity above what you can do with basic
tools. They provide images, patterns, color adjustments, and
more.
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4. Apply the material to the object. Once you have your material
completed, apply it to your aircraft model. Repeat this for other
sections of the model until you are finished, then save your work.
Each new material becomes a separate image in the final file.
That’s not the exact terminology or process, but it’s close enough
for our purposes.

5. Export the .mdl. Your model will now contain the texture data
you need for FS2002, and you can edit it as mentioned
previously.

Working with Scenery

Before you jump into doing anything with scenery in FS2002 Pro, you
need to know that there are literally hundreds, if not thousands, of good
scenery packs available online. Perform an online search for “FS2002
Scenery” and browse around a bit. You’ll be pleasantly surprised at what
you’ll find.

Now, that only applies if you’re looking to edit or create scenery for
a place others have likely seen. If you want to make sure your small
hometown is accurately represented in FS2002, then you’ll most likely
need to do the work yourself.

In order to make your life easier, look for an FS2002 scenery
creation tool on the Internet. My personal favorite is Derek Leung’s FS
Scenery Creator (http://www.geocities.com/deleung8/fssc) because it will
allow you to do just about everything you need, and it provides some great
tutorials to get you there.

You can create just about anything you like and import it into
FS2002 Pro as scenery. FS Scenery Creator lets you do everything—create
runways, taxiways, buildings, radio beacons, and locate your scenery
geographically. If there were not a tool as comprehensive as this, I’d walk
you through the process. However, there’s little point in going through it all
here when you can download the file and work through the provided
tutorials.

As with anything, you can get as detailed as you want. Find an
overhead shot of the area you’re re-creating, and work from that. If you’re
really a glutton for punishment, you could use gmax to create models for
each and every building, but don’t—there’s no point.
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Resources

We’ve come across literally hundreds of online resources that will help you
in your quest to modify FS2002. Here are some of the best links, but as
always, it pays to do a current search when you’re looking for something
specific.

Tools

gmax homepage (www.discreet.com/products/gmax/). You’ll find
general info about gmax here.

gmax support,including forums and tutorials
(www.gmaxsupport.com). We can’t stress the importance of checking the
forums for answers to your questions, as well as using the provided
tutorials.

FS Panel Studio (www.fspanelstudio.com). If you don’t mind
paying for it ($24.99 USD), this is a slick program that will do the work for
you. This nifty program will allow you to modify panels on the fly without
working with the panel.cfg file.

DXTBmp (http://fly.to/mwgfx/). MWGFX software’s freeware
image editing utility.

FS Scenery Creator (www.geocities.com/dleung8/fssc). A great
scenery creator.

General Information

Notes on FS Aircraft Files
(www.maltbyd.fsnet.co.uk/html/notes_on_fs_aircraft_files.htm). A
handy overview.

FlightSim.com (www.flightsim.com). You must go here if you’re
looking for anything related to FS2002.

FlightSim Network (www.flightsimnetwork.com). Another good
overall site with plenty of links and info. The forums are very useful, as is
the rest of the site. You’ll find how-to’s on just about every subject as well
as tons of other resources. Searching the FS2002 forum will get you links to
most of the answers you’re looking for
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Tutorials
gmax Tutorials (http://takeoff.to/landing). Chris File’s excellent
gmax aircraft editing site.

Image editing
(www.avsim.com/hangar/flight/tutorials/tutorials.html). Some good
tutorials on image editing.

Re-painting, texture editing (www.supadetail.co.uk/lesson2.asp).
Good tutorial on re-painting aircraft.
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